
 

 

 

Appendix A: Brief Guide to 
Microsoft Project 2013 

 

Note: This Appendix is an update for An Introduction to 
Project Management, Fourth Edition, and included in 
the Revised Fourth Edition. It is also included in 
Healthcare Project Management, both published in 2013.  

 

By 

Kathy Schwalbe 

Professor, Augsburg College 

Department of Business Administration 

Minneapolis, Minnesota 



 

 

Appendix A: Brief Guide to Microsoft 
Project 2013 

 
©2013 Schwalbe Publishing 
ISBN-13: 978-1448645534  
ISBN-10: 1448645530 
 
ALL RIGHTS RESERVED. No part of this work covered by the copyright hereon may be 
reproduced, transmitted, stored, or used in any form or by any means graphic, electronic, 
or mechanical, including but not limited to photocopying, recording, scanning, digitizing, 
taping, Web distribution, information networks, or information storage and retrieval 
systems, except as permitted under Section 107 or 108 of the 1976 United States Copyright 
Act, without the prior written permission of the author. 

Microsoft and the Office logo are either registered trademarks or trademarks of Microsoft 
Corporation in the United States and/or other countries. All screenshots from Microsoft 
products are used with permission from Microsoft. 

Some of the product names and company names used in this book have been used for 
identification purposes only and may be trademarks or registered trademarks of their 
respective manufacturers and sellers. 

Published by Schwalbe Publishing, in Minneapolis, MN, May 2013.  

Book stores should email schwalbe@augsburg.edu to place orders. Also available from 
www.amazon.com and in electronic format from www.intropm.com.   

Free companion Web site: www.intropm.com.  

Visit www.schwalbepublishing.com or www.kathyschwalbe.com for more 
information on this and other books by Kathy Schwalbe. 



 

 

DETAILED TABLE OF 
CONTENTS 

 
Introduction ..............................................................................................................................................2 
Project Management Software Reviews ...............................................................................................2 
Basic Features of Project Management Software ...............................................................................4 
what’s new in Project 2013.....................................................................................................................6 
Using Project 2013 ..................................................................................................................................7 

Before You Begin ...............................................................................................................................7 
Using the 60-day trial of Project 2013: ............................................................................................8 
Overview of Project 2013 .................................................................................................................8 

Starting Project 2013 and Getting Started .................................................................................9 
Understanding the Main Screen Elements ............................................................................. 12 
Using Project Help and the Project Web Site ........................................................................ 13 

Exploring Project 2013 Using an Existing File ................................................................................ 15 
Project 2013 Views .......................................................................................................................... 17 
Project 2013 Reports ....................................................................................................................... 19 
Project 2013 Filters .......................................................................................................................... 21 

Creating a New File and Entering Tasks in a Work Breakdown Structure ................................. 23 
Creating a New Project File ........................................................................................................... 24 
Creating a Work Breakdown Structure Hierarchy ...................................................................... 25 
Creating Summary Tasks ................................................................................................................ 27 
Numbering Tasks ............................................................................................................................ 28 
Saving Project Files Without a Baseline ....................................................................................... 29 

Developing the Schedule ..................................................................................................................... 30 
Calendars ........................................................................................................................................... 30 
Entering Task Durations ................................................................................................................ 32 

Manual and Automatic Scheduling .......................................................................................... 32 
Duration Units and Guidelines for Entering Durations ...................................................... 33 

Entering Task Durations ................................................................................................................ 36 
Establishing Task Dependencies ................................................................................................... 39 
Gantt Charts, Network Diagrams, and Critical Path Analysis ................................................. 44 

Project Cost and Resource Management .......................................................................................... 47 
Entering Fixed and Variable Cost Estimates .............................................................................. 47 

Entering Fixed Costs in the Cost Table .................................................................................. 48 
Entering Resource Information and Cost Estimates ............................................................ 48 
Using the New Team Planner Feature .................................................................................... 52 

Entering Baseline Plans, Actual Costs, and Actual Times ........................................................ 53 
Viewing Earned Value Management Data ....................................................................................... 57 
Integrating Project 2013 with Other Applications and Apps for office ...................................... 58 



 

 

Copying Information Between Applications ...............................................................................58 
Creating Hyperlinks to Other Files................................................................................................61 
Using Project 2013 Apps .................................................................................................................62 

Discussion Questions ...........................................................................................................................64 
Exercises .................................................................................................................................................64 
End Notes...............................................................................................................................................66 
 
 
  



Appendix A – Microsoft Project            1 

 

  

APPENDIX A: 

Brief Guide to Microsoft 
Project 2013 

 

Note: This guide was written using the free trial of Project 2013 Professional and 
Windows 7. Your screens may appear slightly different. You can download a free 
trial of Project 2013 Professional from www.microsoft.com/project. Also note 
that Microsoft does now provide a cloud-based tool now called Project Online 
available for a monthly fee. 

Visit the free companion Web site at www.intropm.com. You can download the 
files mentioned in this text, access additional resources (including videos on using 
Project 2013 and other tools), purchase this text as a pdf file, and download older 
versions of this guide (for Project 2007 and 2010) for free. 

I would like to thank Dave Klempke and Matt VanZant, adjunct instructors at 
Augsburg College in Minneapolis, for reviewing this appendix. 
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INTRODUCTION 

There are hundreds of project management software products on the market today. 
Gartner estimated the project and portfolio management (PPM) software market to be 
over $1 billion in 2011, and it continues to grow. Unfortunately, many people who own 
PPM software have no idea how to use it. It is important to understand basic concepts of 
project management, such as creating a work breakdown structure, determining task 
dependencies, and so on before making effective use of this software. Many project teams 
still use spreadsheets or other familiar software to help manage projects. However, if you 
can master a good project management software tool, it can really help in managing 
projects. This appendix summarizes basic information on project management software in 
general. It also provides a brief guide to using Microsoft Office Project 2013 Professional 
(often referred to as Project 2013), the latest version of the most widely used PPM 
software.  

PROJECT MANAGEMENT SOFTWARE REVIEWS 

Figure A-1 provides a screen shot showing the top ten project management software 
products based on a June 2009 review by TopTenReviews™. That was the last year that a 
review was provided of non-online PPM software. Most PPM tools now offer totally 
online versions, including Project 2013. The products listed in the top ten include: 

1. Microsoft Project 

2. MindView 

3. Project KickStart 

4. RationalPlan Multi Project 

5. FastTrack Schedule 

6. Service Desktop Pro 

7. Milestones 

8. MinuteMan 

9. FusionDesk Professional 

10. VIP Team To Do List 

Notice that Microsoft Project is number one on the list. Also notice its steep price 
back in 2009 of over $500 for a single user. Remember that students can purchase 
Microsoft Project and other software at greatly reduced rates from sites such as 
www.journeyed.com. You can also download a free trial of Project 2013 Professional (not 
Project Online, which cost $45 per user per month without an annual subscription, as of 
April 2013) and other software products or access them remotely via the Internet with your 
school’s software license. Check with your school’s IT department for more information. 
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Figure A-1. Top ten project management software product comparisons 

Below are descriptions of the criteria for comparing the software products: 

 Collaboration: How information and issues are communicated with 
project team members, including email, conference calls, meetings, 
web-based locations and more. Collaboration should be easy to use.  

 Resource Management: Project management software should 
manage and control the resources needed to run a project, such as 
people, money, time and equipment.  

 Project Management: The process, practice and activities needed to 
perform continuous evaluation, prioritization, budgeting and selection 
of investments are key. Proper project management capabilities 
provide the greatest value and contribution to the strategic interest of 
your company.  

 Ease of Use: All project management software has a learning curve, 
but the best have functions that are easy to find and simple enough 
for anyone to use from Day 1, Project 1.  

 Help/Support: Project management software should offer a 
comprehensive user guide and help system. The manufacturer should 
provide email addresses or telephone numbers for direct answers to 
technical questions.1 

http://project-management-software-review.toptenreviews.com/
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In addition to reviewing project management software in general, 
TopTenReviews™ also compared online products in a separate category. These products 
require an Internet connection for use. Figure A-2 lists the top ten results for 2013. The 
top ten products listed include: 

1. Clarizen 

2. Genius Project 

3. Daptiv 

4. Tenrox 

5. Celoxis 

6. Project Insight 

7. AtTask 

8. EPM Live 

9. Liquid Planner 

10. Easy Projects.net 

TopTenReviews™ only listed online project management tools in 2013, and their 
review was done before Microsoft’s Project Online was released. Tools in this list provide 
the ability to create Gantt charts, numerous reports and views, project dashboards, and 
integrate with Microsoft Project files. See End Note 2 or visit the Web sites for any of 
these products and use a free trial version. Also note that there are many other tools 
available.  

BASIC FEATURES OF PROJECT MANAGEMENT 
SOFTWARE 

What makes project management software different from other software tools? Why not 
just use a spreadsheet or database to help manage projects? 

 You can do a lot of project management planning and tracking using non-project 
management software. You could use a simple word processor to list tasks, resources, 
dates, and so on. If you put that information into a spreadsheet, you can easily sort it, graph 
it, and perform other functions. A relational database tool could provide even more 
manipulation of data. You can use email and other tools to collaborate with others.  
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Figure A-2. Top ten online project management product comparisons2 

 However, project management software is designed specifically for managing 
projects, so it normally includes several distinct and important features not found in other 
software products: 

 Creating work breakdown structures, Gantt charts, and network diagrams: A fundamental 
concept of project management is breaking down the scope of the project into a 
work breakdown structure (WBS). The WBS is the basis for creating the project 
schedule, normally shown as a Gantt chant. The Gantt chart shows start and end 
dates of tasks as well as dependencies between tasks, which are more clearly shown 
in a network diagram. Project management software makes it easy to create a WBS, 
Gantt chart, and network diagram. These features help the project manager and 
team visualize the project at various levels of detail.  

 Integrating scope, time, and cost data: The WBS is a key tool for summarizing the scope 
of a project, and the Gantt chart summarizes the time or schedule for a project. 
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Project management software allows you to assign cost and other resources to 
tasks on the WBS, which are tied to the schedule. This allows you to create a cost 
baseline and use earned value management to track project performance in terms 
of scope, time, and cost in an integrated fashion. 

 Setting a baseline and tracking progress: Another important concept of project 
management is preparing a plan and measuring progress against the plan. Project 
management software lets you track progress for each task. The tracking Gantt 
chart is a nice tool for easily seeing the planned and actual schedule, and other 
views and reports show progress in other areas. 

 Providing other advanced project management features: Project management software often 
provides other advanced features, such as setting up different types of scheduling 
dependencies, determining the critical path and slack for tasks, working with 
multiple projects, and leveling resources. For example, you can easily set up a task 
to start when its predecessor is halfway finished. After entering task dependencies, 
the software should easily show you the critical path and slack for each task. You 
can also set up multiple projects in a program and perform portfolio management 
analysis with some products. Many project management software products also 
allow you to easily adjust resources within their slack allowances to create a 
smoother resource distribution. These advanced features unique to project 
management are rarely found in other software tools. 

As you can see, there are several important features that are unique to project 
management software that make them worth using. Next you’ll learn what’s new in Project 
2013 and how to use basic features. 

WHAT’S NEW IN PROJECT 2013 

If you are familiar with Project 2010 or earlier version, it may be helpful to review some of 
the new features in Project 2013.  

 Improved reports: With Project 2013, you can create professional reports and add 
pictures, charts, animation, and links to clearly share project status information. An 
entirely new set of pre-installed reports are available, including burndown reports, 
a popular chart used for agile projects. The earned value chart is also much easier 
to create.  

 New collaboration features: You can stay in touch with team members by getting 
progress updates, asking questions, or having strategy discussions, all without 
leaving Project 2013. You can hover over a name and start an IM session, video 
chat, email, or phone call. You must have Lync 2010 or later installed to take 
advantage of this feature. 

 Task paths: You can now highlight any task and see its task path. All of the task’s 
predecessor tasks show up in one color, and all of its successor tasks show up in 
another color. 

 Extended dates: You can set task and project dates up to 12/31/2149.  
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 Shared meetings: If you export Project 2013 reports, timelines, or data to other 
Office programs, you can use the new sharing feature to join online meetings, 
share your PowerPoint slides, Word documents, Excel spreadsheets, and OneNote 
notes from any supported device, even if Office isn’t installed. 

 Cloud storage: You can easily save files to your own SkyDrive or to your 
organization’s shared site. From there you can access and share your files from 
Project 2013 and other Office applications. Note that Project Online is delivered 
through Office 365 and used totally online. 

 Easy access: If you have Project Online, Windows 7 (or later), and an internet 
connection, you can access a full version of Project from any location, similar to 
the new Office applications.  

 Next, you will learn some basic information about Project 2013 and explore the 
main screen elements and Help facility. 

USING PROJECT 2013 

Before you can use Project 2013 or any project management software effectively, you must 
understand the fundamental concepts of project management, such as creating work 
breakdown structures (WBS), linking tasks, entering duration estimates, assigning resources, 
and so on. The purpose of this text is to  provide specific instructions for using Project 
2013 Professional. Consult Microsoft’s Web site for detailed information on other products 
and other resources to help you understand project management concepts. 

Before You Begin 

This appendix assumes you are using Project 2013 with Windows 7 (or later) and are 
familiar with other Windows-based applications. Check your work by reviewing the many 
screen shots included in the steps, or by using the solution files that are available for 
download from the companion Web site for this text or from your instructor.  

NOTE: You need to be running Windows 7 or later to use Project 2013, a 1 Ghz or greater x86/x64 
processor with SSE2 instruction set, 1 GB RAM (32 Bit) / 2 GB RAM (64 Bit), and an up-to-date 
browser. Certain features require internet connectivity. You can read more detailed system 
requirements and download a free trial from www.microsoft.com/project. Students can 
purchase a full version from sites like www.journeyed.com at a discount. Many colleges and 
universities provide the software to students either on campus or through remote access. If 
you can use remote access, the main requirement is internet connectivity. Check with your 

instructor for details. You might also want to pay for monthly access to Project Online. 

This appendix uses a fictitious project—Project A+—to illustrate how to use the 
software. The WBS for Project A+ uses the five project management process groups as 
level 2 items (initiating, planning, executing, monitoring and controlling, and closing). 
Standard deliverables under each of those process groups are included. Each section of the 
appendix includes hands-on activities for you to perform.  

http://office.microsoft.com/en-us/project-help/redir/XT103239135.aspx?CTT=5&origin=HA102749523
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NOTE: To complete some of the hands-on activities in the appendix, you will need to 
download files from the companion Web site for this text (www.intropm.com) to your 
computer. When you begin each set of steps, make sure you are using the correct file. Save 
the files you create yourself in a different folder so you do not write over the ones you 
download. 

In addition, you will create the following files from scratch as you work through 
the steps: 

 mywbs.mpp 

 myschedule.mpp 

You will also use the following file to create a hyperlink: 

 stakeholder register.doc 

Using the 60-day trial of Project 2013: 

If you plan to download the free trial, perform the following steps: 
1. Go to www.microsoft.com/project and click on the Try button under Project 

Professional 2013.  

2. Enter your account information. You do need a Microsoft account. It used to be 

called a Windows Live account, so you may already have one if  you set it up for 

Xbox 360, SkyDrive, Office 2013, Office 365 or other items. If  you do not have a 

Microsoft account, set one up for free. 

3. Install Project 2013. The installation for Project 2013 is a bit different from past 

installations. Microsoft has you download some software (an image file) and then 

burn it to a CD or hard drive. You then run the software to install the 60-day trial.  

Be sure to save the product key Microsoft provides and enter it when prompted, 

and select the automatic upgrade. The trial software is run through Microsoft’s 

online environment, similar to Office 365.  

 Next you will learn how to start Project 2013, review the Help facility and a 
template file, and begin to plan Project A+. 

Overview of Project 2013 

The first step to mastering Project 2013 is to become familiar with the major screen 
elements and the Help facility. This section describes each of these features. 

  

http://www.microsoft.com/project
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Starting Project 2013 and Getting Started 

To start Project 2013: 

1. Open Project 2013. There are slightly different methods for opening Project 2013 
depending on your operating system. For example, in Windows 7, click the Start 
button on the taskbar, and then click Project 2013 or type it in the search bar. 
Alternatively, a shortcut or icon might be available on the desktop; in this case, 
double-click the icon to start the software. 

2. Review the Get Started feature. Click on Get Started, as shown in the upper right 

section of Figure A-3. 

 

Figure A-3. Project 2013 initial options – access Get Started 

3. Start the introduction. Click Create, and then click Start, as shown in Figure A-4. 

 

Figure A-4. Project 2013 Get Started introductory screen 
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4. Review the “4 simple steps” Microsoft lists for using Project 2013. Review the first step, 

called Schedule your work, as shown in Figure A-5. Review the other steps by 

clicking Next, as shown in Figures A-6-A-8. 

 

Figure A-5. Schedule your work screen 

 

Figure A-6. Create a timeline screen 

 



Appendix A – Microsoft Project            11 

 

  

 

Figure A-7. Report on progress screen 

 

Figure A-8. Collaborate with your team screen 

 
5. Explore Help features. The last screen of Getting Started, Learn More, as shown in 

Figure A-9, provides links to the Project 2013 Getting Started Center (which 

includes a short video on what’s new that is worth watching) and the Project blog. 

The help feature (question mark in the upper right of the screen) also includes a lot 

of helpful resources. 

http://office.microsoft.com/en-us/project-help/what-s-new-in-project-2013-HA102749523.aspx?WT%2Emc_id=O15WelcomeDoc
http://blogs.office.com/b/project/
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Figure A-9. Learn More screen 

Understanding the Main Screen Elements 

To open a blank file: 

1. Open a blank file. Click the File tab, New, and then click the first option, Blank 
Project.  

2. Examine the main screen. Review the main screen elements, as shown in Figure 
A-10. Look at some of the elements of the screen.  

 The Ribbon, tabs, and Quick Access toolbar are similar to other Office 
applications. 

 The timeline view is displayed below the ribbon. 

 The default manual scheduling for new tasks is on the lower left of the 
screen. You can click that option to switch to automatic scheduling. 

 The default view is the Gantt chart view, which shows tasks and other 
information as well as a calendar display. You can access other views by 
clicking the View icon on the far left side of the ribbon. 

 The areas where you enter information in a spreadsheet-like table are part 
of the Entry table. For example, you can see entry areas for Task Name, 
Duration, Start, Finish, and Predecessors. 

 You can make the Entry table more or less wide by using the Split bar. 
When you move the mouse over the split bar, your cursor changes to the 
resize pointer. Clicking and dragging the split bar to the right reveals 
columns for Resource Names and Add New columns. 

 The first column in the Entry table is the Indicators column. The 
Indicators column displays indicators or symbols related to items 
associated with each task, such as task notes or hyperlinks to other files. 
The second column displays if a task is manually or automatically 
scheduled, as described later in this appendix. 

 The file name displays centered at the top of the screen. When you open a 
Blank Project after starting Project 2013, it opens a new file named 
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Project1, which is shown in the title bar. If you open a second Blank 
Project, the name will be Project2, and so on, until you save and rename 
the file. 

 
  Indicators column    Tabs     Entry table    Gantt chart view (default view) 

 

Figure A-10. Project 2013 main screen 

Using Project Help and the Project Web Site 

To access information to help you learn how to use Project 2013: 

1. Access Project Help. Click on the question mark/help icon on the upper side of the 
ribbon. The Project Help screen displays, as shown in Figure A-11. Remember that 
this feature requires an Internet connection.  

Quick 
Access 
Toolbar 
 
Ribbon 
 
Timeline 
 
 
Split bar 
 
 
 
 
Manual/ 
automatic 
scheduling 
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Figure A-11. Topics under Project help 

2. Explore various help topics Click the Project Help link called “What’s new with 
Project 2013.” Microsoft provides short videos, steps, templates, articles, and 
other features to help you learn to use this powerful software. Watch the short 
video, read the other information on the page, and explore links for more help. 

3. Close Project 2013. Click the Close icon (X in the upper right of the screen) to exit 
Project 2013. 

Many features in Project 2013 are similar to ones in other Windows programs. For 
example, to collapse or expand tasks, click the appropriate symbols to the left of the task 
name. To access shortcut items, right-click in either the Entry table area or the Gantt chart. 
Many of the Entry table operations in Project 2013 are very similar to operations in Excel. 
For example, to adjust a column width, click and drag between the column heading titles. 

Next, you will get some hands-on experience by opening an existing file to explore 
various screen elements. Project 2013 comes with several template files, and you can also 
access templates from Microsoft Office Online or other Web sites.  
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EXPLORING PROJECT 2013 USING AN EXISTING 
FILE 

To open a template file and adjust Project 2013 screen elements: 

1. Open Project 2013 and select the Customer Service template file. Click the Start button on 
the taskbar, select Project 2013, click Customer Service, and then click Create. 
These screen shots were taken on April 3, 2013, so you can enter that date if  you 
like. Your screen should resemble Figure A-12. (Note: If  you cannot find the 
template, you can download it from www.intropm.com and open it. To open an 
existing file, click the File tab, then select Open, and browse to find the file.) 

2. Widen the Task Name column. Move the cursor between the Task Name and 
Duration columns, and then double-click to widen the Task Name column so all 
of  the text shows in one line. 

3. Move the Split Bar. Move the Split Bar to the right so the entire Task Name column 
text is visible, but not the Duration column. The default table view is the Entry 
table. 

4. View the first Note: Move your mouse over the yellow Notes symbol in the 
Indicators column for Task 1 to read it. You can insert notes by any task. 

Note Indicator       Widen Column                  Split Bar    Timeline      Notes 

 

 

 Figure A-12. Customer Service template file 
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To show different WBS levels: 

1. Select Outline Level 1 to display WBS level 2 tasks. Click the View tab and then the Outline 
button’s list arrow, and then click Outline Level 1. Notice that only the level 2 WBS 
items display in the Entry table.  The black bars on the Gantt chart represent the 
summary tasks. Recall that the entire project is normally referred to as WBS level 1, 
and the next highest level is called level 2.  

2. Adjust the timescale. Click the Zoom out button (minus sign) on the left side of  the 
Zoom slider on the lower left of  the screen, as shown in Figure A-13. Notice the 
milestone task in row 143 indicating the project completion date. Recall that the black 
diamond symbol on a Gantt chart shows milestones. 

3. Expand a task. Click the expand symbol to the left of  Task 2, Initial Assessment, to 
see its subtasks. Click the collapse symbol to hide its subtasks. Experiment with 
expanding and collapsing other tasks and resizing other columns.  

Expand/Collapse Symbol      Outline  Summary Tasks           Timeline  Zoom out   Milestone 

 

Figure A-13. Showing part of the WBS on the Gantt chart 

4. View all tasks. Click Outline button and select All Subtasks to see all of the items in 
the Task Name column again.  

5. Remove the Timeline. Click the Timeline checkbox on the Ribbon to unselect it. Click it 
again to display it. 
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6. Close the file without saving. Click the Close icon in the upper right of the window, 

and select No when prompted to save the file. 

Project 2013 Views 

Project 2013 provides many ways to display or view project information. In addition to the 
default Gantt chart, you can view the network diagram, calendar, and task usage views, to 
name a few. These views allow you to analyze project information in different ways.  The 
View tab also provides access to different tables that display information in various ways. 
In addition to the default Entry table view, you can access tables that focus on data related 
to areas such as the Schedule, Cost, Tracking, and Earned Value. 

 To access and explore different views: 

 1. Explore the Network Diagram for the Customer Service file. Open the Customer 
Service file again.  Click the Network Diagram button under the View tab, and 
then move the Zoom slider on the lower right of  the screen all the way to the left. 
Your screen should resemble Figure A-14. Critical tasks display in red. 

Network Diagram                   Zoom Slider 

 

 

Figure A-14. Network diagram view of Customer Service file 

2. Explore the Calendar view. Click the Calendar button (under the Network 
Diagram button). Notice that the screen lists tasks each day in a calendar format. 
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3. Change the table view. Click the Gantt Chart button on the ribbon, click the 
Tables button under the View tab, and then click Schedule. Figure A-15 shows 
the table view options.  

 

Figure A-15. Table view options 

4. Examine the Schedule table and other views. Select the Schedule table view and 

move the Split bar to the right to review the Total Slack column. Notice that the 
columns in the table to the left of  the Gantt chart, as shown in Figure A-16, now 
display more detailed schedule information, such as Late Start, Late Finish, Free 
Slack, and Total Slack. Remember that you can widen columns by double-clicking 
the resize pointer to the right of  that column. You can also move the split bar to 
reveal more or fewer columns. Experiment with other table views, then return to 
the Entry table view. 
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Figure A-16. Schedule table view 

Project 2013 Reports 

Project 2013 provides many ways to report project information as well. In addition to 
traditional reports, you can also prepare visual reports, with both available under the 
Report tab. Note that the visual reports often require that you have other Microsoft 
application software, such as Excel and Visio. Project 2013 automatically formats reports 
for ease of printing.  

To access and explore different reports: 

 1. Explore the Reports feature. Click the Report tab to see the variety of  reports 
available in Project 2013, as shown in Figure A-17. 

 

Figure A-17. Report options 



20 Appendix A – Microsoft Project 

 

2. View the Project Overview report. Click Dashboards, and then double-click 
Project Overview. Review the report and new options on the ribbon, as shown in 
Figure A-18.  

 

Figure A-17. Project Overview report 

3. Open the Resource Overview report. Click the Report tab again, click Resources, 
and then click Resource Overview. Review the report, as shown in Figure A-18. 

 

Figure A-18. Resource Overview report 
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4. Examine the report and experiment with others. Click on the Report tab, click In 
Progress, and then click Critical Tasks to display the Critical Tasks report, as 
shown in Figure A-19. Examine other reports. 

5. Return to the Gantt chart. Click the View tab, and then click on Gantt Chart to 
return to the Gantt chart view. You can close the file without saving it if  you wish 
to take a break. 

 

Figure A-19. Critical tasks report 

Project 2013 Filters 

Project 2013 uses a relational database to filter, sort, store, and display information. 
Filtering project information is very useful. For example, if a project includes thousands of 
tasks, you might want to view only summary or milestone tasks to get a high-level view of 
the project by using the Milestones or Summary Tasks filter from the Filter list. You can 
select a filter that shows only tasks on the critical path if that is what you want to see. Other 
filters include Completed Tasks, Late/Overbudget Tasks, and Date Range, which displays 
tasks based on dates you provide. As shown earlier, you can also click the Show button on 
the toolbar to display different levels in the WBS quickly.  
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To explore Project 2013 filters: 

1. Access filters. Click the View tab, if  necessary, and make sure the Customer 
Service file is in the Gantt Chart: Table Entry view. Click the Filter list arrow 
(under the Data group), as shown in Figure A-20. The default filter is No Filter, 
which shows all tasks.  

 

 

 

Figure A-20. Using a filter 

2. Filter to show milestones. Click Milestones in the list of  filters. Notice that the 
Gantt chart only shows the summary tasks and milestones for the project. Your 
screen should resemble Figure A-21. Recall that milestones are significant events. 

3. Show critical tasks. Select No Filter from the Filter list box to reveal all the tasks 
in the WBS again. Click the Filter list arrow, and then click Critical Tasks. Now 
only the critical tasks appear in the WBS. Experiment with other filters. 

4. Close the file. When you are finished reviewing the Customer Service file, click 
Close from the File tab or click the Close button. Click No when asked if  you 
want to save changes. 

5. Exit Project 2013. Click the Close button for Project 2013. 

 

Filter list arrow 
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Figure A-21. Milestones filter applied 

Now that you are familiar with the main screen elements, views, reports, and 
filters, you will learn how to use Project 2013 to create a new file. 

CREATING A NEW FILE AND ENTERING TASKS 
IN A WORK BREAKDOWN STRUCTURE 

To create a new Project 2013 file, you must first name the project, enter the start date, and 
then enter the tasks. The list of tasks and their hierarchy is the work breakdown structure 
(WBS). The file you create could be used for a class project which lasts approximately three 
months. It uses the project management process groups to reinforce use of several project 
management deliverables described in this text. You could modify this file to meet your 
specific needs. 

 

NOTE: In this section, you will go through several steps to create a new Project 2013 file 
named mywbs.mpp. If you want to download the completed file to check your work or 
continue to the next section, a copy of mywbs.mpp is available on the companion Web site 
for this text at www.intropm.com. Try to complete an entire section of this appendix 
(entering tasks in a work breakdown structure, developing the schedule, and so on) in one 
sitting to create the complete file.  
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Creating a New Project File 

To create a new project file: 

1. Create a blank project. Open Project 2013 and click on Blank Project. A blank 
project file opens with a default filename of  Project1, Project2, and so on. (If  
Project 2013 is already open and you want to open a new file, click the File tab, 
select New, and then Blank Project.) 

2. Open the Project Information dialog box. Click the Project tab, and then click 
Project Information to display the Project Information dialog box, as shown in 
Figure A-22. This dialog box enables you to set dates for the project, select the 
calendar to use, and view project statistics. The project start date will default to the 
current date. Note that in Figure A-22 the file was created on 4/3/13 and a Start 
date of  9/9/13 was entered. 

NOTE: All dates are entered in month/day/year or American format. You can change the 
date format by selecting Options from the File tab. Click the date format you want to use 
in the Date Format box under the General settings. You can also customize the Ribbon, 
change default currencies in the display, and so on under Project Options. 

 

3. Enter the project start date. In the Start date text box, enter 9/9/13. Setting your 
project start date to 9/9/13 will ensure that your work matches the results that 
appear in this appendix. Leave the Current date and other information at the 
default settings. Click OK or press Enter. 

4. Enter advanced project properties. Click the File tab, and then click Info. Click 
Project Information on the right side of  the screen, and then click Advanced 
Properties. Enter Project A+ for the title, if  you want to change the title. You can 
also enter a subject, author, and other information as desired. Click the left arrow 
at the top left of  the screen to go back to the previous screen. 
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Figure A-22. Project information dialog box 

Creating a Work Breakdown Structure Hierarchy 

As mentioned earlier, a work breakdown structure (WBS) is a fundamental part of project 
management. Developing a good WBS takes time, and it will make entering tasks into the 
Entry table easier if you develop the WBS first. For this example, you will use the project 
management process groups as the level 2 items and add some key deliverables and 
milestones under each one. You will use the information in Figure A-23 to enter tasks. 
Note that Microsoft Project uses the term tasks instead of deliverables or activities or 
milestones, so it is also used in this appendix. 
  

Start 
date 
text box 

Current 

date 



26 Appendix A – Microsoft Project 

 

 

1. Initiating 16. Deliverable 2 

2. Stakeholder identification 17. Deliverable 3 

3. Stakeholder register completed 18. Deliverable 1 completed 

4. Stakeholder management strategy 
completed 

19. Deliverable 2 completed 

5. Project charter 20. Deliverable 3 completed 

6. Project charter completed 21. Monitoring and Controlling 

7. Kickoff  meeting 22. Actual hours tracking 

8. Kickoff  meeting completed 23. Project documents updates 

9. Planning 24. Progress report 1 

10. Schedule 25. Progress report 2 

11. Gantt chart completed 26. Team review meetings 

12. Scope statement 27. Closing 

13. Initial scope statement completed 28. Final project report 

14. Executing 29. Final project presentation 

15. Deliverable 1 30. Project completed 

Figure A-23. Task list for Project A+ 

To develop a WBS for the project: 

1. Enter task names. Enter the 30 items in Figure A-23 into the Task Name 
column in the order shown. To not have the text wrap, click on the Format Tab, 
click Column Settings, and then click Wrap Text to turn it off. Do not worry 
about durations or any other information at this time. Type the name of  each item 
into the Task Name column of  the Entry table, beginning with the first row. Press 
Enter or the down arrow key on your keyboard to move to the next row.  

HELP: If you accidentally skip a row, highlight the task row, right-click, and select Insert 
Task. To edit a task entry, click the text for that task, and either type over the old text or 
edit the existing text. Entering tasks into Project 2013 and editing the information is similar 
to entering and editing data in an Excel spreadsheet. You can also easily copy and paste text 
from Excel or Word into Project, such as the list of tasks. 

 



Appendix A – Microsoft Project            27 

 

  
2. Adjust the Task Name column width as needed. To make all the text display in the 
Task Name column, move the mouse over the right-column gridline in the Task 
Name column heading until you see the resize pointer , and then click the left 
mouse button and drag the line to the right to make the column wider, or double-
click to adjust the column width automatically. 

This WBS separates tasks according to the project management process groups of 
initiating, planning, executing, controlling, and closing. These categories will be the level 2 
items in the WBS for this project. (Remember the whole project is level 1.) It is a good idea 
to include all of these process groups because there are important deliverables that must be 
done under each of them. Recall that the WBS should include all of the work required for 
the project. In the Project A+ WBS, the WBS will be purposefully left at a high level (level 
3). You will create these levels, or the WBS hierarchy, next when you create summary tasks. 
For a real project, you would usually break the WBS into even more levels and then enter 
activities to provide more details to describe all the work involved in the project. For 
example, each deliverable would probably have several levels, activities, and milestones 
under it. You can review other Project 2013 template files or other sources for more 
information.  

Creating Summary Tasks 

After entering the items listed in Figure A-23 into the Entry table, the next step is to show 
the WBS levels by creating summary tasks. The summary tasks in this example are Tasks 1 
(initiating), 9 (planning), 14 (executing), 21 (monitoring and controlling), and 27 (closing). 
You create summary tasks by highlighting and indenting their respective subtasks. 

To create the summary tasks: 

1. Select lower level or subtasks. Highlight Tasks 2 through 8 by clicking the cell for 
Task 2 and dragging the mouse through the cells to Task 8. 

2. Indent subtasks. Click the Indent Tasks button on the Ribbon under the 
Schedule group of  the Task tab (or press Alt + Shift + right arrow) so your screen 
resembles Figure A-24. After the subtasks (Tasks 2 through 8) are indented, notice 
that Task 1 automatically becomes boldface, which indicates that it is a summary 
task. A collapse symbol appears to the left of  the new summary task name. 
Clicking the collapse symbol (filled triangle sign) will collapse the summary task 
and hide the subtasks beneath it. When subtasks are hidden, an expand symbol 
(unfilled triangle sign) appears to the left of  the summary task name. Clicking the 
expand symbol will expand the summary task. Also, notice that the symbol for the 
summary task on the Gantt chart has changed from a blue to a black line with 
arrows indicating the start and end dates. The Task Mode has also changed to 
make this task Automatically scheduled. You’ll learn more about this feature later. 
For now, focus on entering and indenting the tasks to create the WBS. 
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Expand or collapse symbols by 
Summary tasks        Indent Task    Summary task symbol 

 

Figure A-19. Indenting tasks to create the WBS hierarchy 

3. Create other summary tasks and subtasks. Create subtasks and summary tasks for the 
other process groups by following the same steps. Indent Tasks 10 through 13 to make 
Task 9 a summary task. Indent Tasks 15 through 20 to make Task 14 a summary task. 
Indent Tasks 22 through 26 to make Task 21 a summary task. Indent Tasks 28 through 
30 to make Task 27 a summary task. Widen the Task Name column to see all of  your 
text, as needed. 

TIP: To change a task from a subtask to a summary task or to change its level in the 
WBS, you can “outdent” the task. To outdent the task, click the cell of the task or tasks 
you want to change, and then click the Outdent Task button (the button just to the left 
of the Indent Task button). You can also press Alt + Shift + Right Arrow to indent 
tasks and Alt + Shift + Left Arrow to outdent tasks. 

Numbering Tasks 

To display automatic numbering of tasks using the standard tabular numbering system for a 
WBS: 

1. Show outline numbers. Click the Format tab, and then click the Outline 
Number checkbox under the Show/Hide group. Project 2013 adds the 
appropriate WBS numbering to the task names. 

2. Show project summary task. Click the Project Summary checkbox just below the 
Outline Number checkbox. Scroll to the top of  the file to see that a new task, 
Project A+, the title of  the project, has been added under row 0. Your file should 
resemble Figure A-25. 
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       Outline Number and Project Summary Task Check Boxes 
 
Outline Numbers         Project Summary Task 

 

 

Figure A-25. Adding automatic outline numbers and a project summary task 

Saving Project Files Without a Baseline 

An important part of project management is tracking performance against a baseline, or 
approved plan. It is important to wait until you are ready to save your file with a baseline 
because Project 2013 will show changes against a baseline. Since you are still developing 
your project file for the Project A+ project, you want to save the file without a baseline, 
which is the default way to save a file. Later in this appendix, you will save the file with a 
baseline. You will then enter actual information to compare planned and actual 
performance data. 

To save a file without a baseline: 

1. Save your file. Click the File tab and then click Save, or click the Save button on 
the Quick Access toolbar. 

2. Enter a filename. In the Save dialog box, type mywbs in the File name text box. 
Browse to the location in which you want to save the file, and then click Save. 
Remember that you can move the Split bar to show more or fewer columns. 

3. Close Project 2013. Click the Close icon to exit Project 2013. 
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HELP: If you want to download the Project 2013 file mywbs.mpp to check your work or 
continue to the next section, a copy is available on the companion Web site for this text at 
www.intropm.com. 

DEVELOPING THE SCHEDULE 

Many people use Project 2013 for its scheduling features. The first step in using these 
features, after inputting the WBS for the project, is to change calendars, if needed, and then 
enter durations for tasks or specific dates when tasks will occur. You must also enter task 
dependencies in order for schedules to adjust automatically and to do critical path analysis. 
After entering durations and task dependencies, you can view the network diagram, critical 
path, and slack information.  

Calendars 
The standard Project 2013 calendar assumes that working hours are Monday through 
Friday, from 8:00 a.m. to 5:00 p.m., with an hour for lunch from noon until 1:00 p.m.  In 
addition to the standard calendar, Project 2013 also includes a 24 Hours calendar and Night 
Shift calendar. The 24 Hours calendar assumes resources can work any hour and any day of 
the week. The Night Shift calendar assumes working hours are Monday through Saturday, 
from 12:00 a.m. to 3:00 a.m., 4:00 a.m. 8 a.m., and 11 p.m. to 12 a.m. You can create a 
different base calendar to meet your unique project requirements.  
 
 To create a new base calendar: 

1. Open a new file and access the Change Working Time dialog box. With Project 2013 
open, click the Project tab, and then click the Change Working Time button 
under the Properties group. The Change Working Time dialog box opens, as 
shown in Figure A-26. 

2. Name the new base calendar. In the Change Working Time dialog box, click 
Create New Calendar. The Create New Base Calendar dialog box opens. Click 
the Create new base calendar radio button, type Fiscal as the name of the new 
calendar in the Name text box, and then click OK.  

3. Change the fiscal year start. In the Change Working Time dialog box, click 
Options at the bottom of the screen. Change the fiscal year to start in October 
instead of January. Review other options in this screen, and then click OK twice. 
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Figure A-26. Change Working Time dialog box 

You can use this new calendar for the whole project, or you can assign it to 
specific resources on the project. 

To assign the new calendar to the whole project: 

1. Open the Project Information dialog box. Click the Project tab, and then click the 
Change Working Time button.  

2. Select a new calendar. Click the For calendar list arrow to display a list of 
available calendars. Select your new calendar named Fiscal from this list, and then 
click OK. 

To assign a specific calendar to a specific resource: 

1. Assign a new calendar. Click the View tab, and then click the Resource Sheet 
button under the Resource Views group. Type Adam in the Resource Name 
column, press Enter, and then select the word Adam. 
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2. Select the calendar. Click the cell under the Base column that says Standard on 
the right part of the screen for Adam. Click the list arrow to display the options, 
and then select Fiscal as shown in Figure A-27. 

 

Figure A-27. Changing calendars for specific resources 

3. Block off vacation time. Double-click the resource name Adam to display the 

Resource Information dialog box, and then click the Change Working Time 
button, located on the General tab in the Resource Information dialog box. You 
can block off vacation time for people by selecting the appropriate days on the 
calendar and marking them as nonworking days. Click OK to accept your changes, 
and then click OK to close the Resource Information dialog box. 

4. Close the file without saving it. Click the Close box, and then click No when you 
are prompted to save the file. 

Entering Task Durations 

Recall that duration includes the actual amount of time spent working on an activity plus 
elapsed time. Duration does not equal effort.  For example, you might have an activity that 
you estimate will take one person 40 hours of effort to complete, but you allow two weeks 
on a calendar for its duration. You can simply enter 2w (for two weeks) in the Duration 
column for that activity (called a task in Project 2013). 

Manual and Automatic Scheduling 

If you have used earlier versions of Project, you probably noticed that when you entered an 
item in the Task Name column, it was automatically assigned a duration of one day, and 
Start and Finish dates were also automatically entered. This is still the case in Project 2013 
if you use automatic scheduling for a task. If you use manual scheduling, no durations or 
dates are automatically entered. The other big change with manual scheduling is that 
summary task durations are not automatically calculated based on their subtasks when they 
are set up as manually scheduled tasks. Figure A-28 illustrates these differences. Notice that 
the Manual subtask 1 had no information entered for its duration, start, or finish dates. 
Also note that the duration for Manual summary task 1’s duration is not dependent on the 
durations of its subtasks. For the automatic summary task, its duration is dependent on its 
summary tasks, and information is entered for all of the durations, start, and end dates. You 
can switch between automatic and manual scheduling for tasks in the same file, as desired, 
by changing the Task Mode. 
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Figure A-28. Manual versus automatic scheduling 

When you move your mouse over the Task Mode column (shown in the far left in 
Figure A-28) Project 2013 displays the following information:  

 A task can be either Manually Scheduled or Automatically Scheduled. 

 Manually Scheduled tasks have user-defined Start, Finish and Duration 
values. Project will never change their dates, but may warn you if there are 
potential issues with the entered values. 

 Automatically Scheduled tasks have Start, Finish and Duration values calculated by 
Project based on dependencies, constraints, calendars, and other factors. 

 
 Project Help provides the following example of using both manual and automatic 
scheduling. You set up a preliminary project plan that’s still in the proposal stage. You have 
a vague idea of major milestone dates but not much detail on other dates in various phases 
of the project. You build tasks and milestones using the Manually Scheduled task mode. 
The proposal is accepted and the tasks and deliverable dates become more defined. You 
continue to manually schedule those tasks and dates for a while, but as certain phases 
become well-defined, you decide to switch the tasks in those phases to the Automatically 
Scheduled task mode. By letting Project 2013 handle the complexities of scheduling, you 
can focus your attention on those phases that are still under development.   

Duration Units and Guidelines for Entering Durations 

To indicate the length of a task’s duration, you normally type both a number and an 
appropriate duration symbol. If you type only a number, Project 2013 automatically enters 
days as the duration unit. Duration unit symbols include: 

 d = days (default) 

 w = weeks 

 m = minutes 

 h = hours 

 mo or mon = months 

 ed = elapsed days 

 ew = elapsed weeks 
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For example, to enter two weeks for a task’s duration, type 2w in the Duration 
column. (You can also type wk, wks, week, or weeks, instead of just w.) To enter four days 
for a task’s duration, type 4 or 4d in the Duration column. You can also enter elapsed times 
in the Duration column. For example, 3ed means three elapsed days, and 2ew means two 
elapsed weeks. 

You would use an elapsed duration for a task like “Allow cement to dry.” The 
cement will dry in exactly the same amount of time regardless of whether it is a workday, a 
weekend, or a holiday. Project’s default calendar does not assume that work is done on 
weekends. You will learn to change the calendar later in this appendix. 

It is important to follow a few important rules when entering durations: 

 To mark a task as a milestone, enter 0 for the duration. You can also mark 
tasks that have a non-zero duration as milestones by checking the “Mark task 
as milestone” option in the Task Information dialog box on the Advanced tab. 
You simply double-click a task to access this dialog box. The milestone symbol 
for those tasks will appear at their start date. 

 You can enter the exact start and finish dates for activities instead of  entering 
durations in the automatic scheduling mode. To enter start and finish dates, 
move the split bar to the right to reveal the Start and Finish columns. You 
normally only enter start and finish dates in this mode when those dates are 
certain. 

 If  you want task dates to adjust according to any other task dates, do not enter 
exact start and finish dates. Instead, enter durations and then establish 
dependencies to related tasks.  

 To enter recurring tasks, such as weekly meetings, select Recurring Task from 
the Task button under the Task tab, Insert group. Enter the task name, the 
duration, and when the task occurs. Project 2013 will automatically insert 
appropriate subtasks based on the length of  the project and the number of  
tasks required for the recurring task.  

 Project 2013 uses a default calendar with standard workdays and hours. 
Remember to change the default calendar if  needed, as shown earlier.  

Next, you will set task durations in the file that you created and saved in the 
previous section. If you did not create the file named mywbs.mpp, you can download it 
from the companion Web site for this text.  

Use the information in Figure A-29 to enter durations. The Project 2013 row 
number is shown to the left of each task name in the table. 
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Task Row Task Name Duration 

2 Stakeholder identification 1w 

3 Stakeholder register completed 0 

4 Stakeholder management strategy completed 0 

5 Project charter 1w 

6 Project charter completed 0 

7 Kickoff meeting 3d 

8 Kickoff meeting completed 0 

10 Project schedule 5d 

11 Gantt chart completed 0 

12 Scope statement 8d 

13 Initial scope statement completed 0 

15 Deliverable 1 3w 

16 Deliverable 2 5w 

17 Deliverable 3 6w 

18 Deliverable 1 completed 0 

19 Deliverable 2 completed 0 

20 Deliverable 3 completed 0 

24 Progress report 1 0 

25 Progress report 2 0 

28 Final project report 4d 

29 Final presentation 4d 

30 Project completed 0 

Figure A-29. Task durations 
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Entering Task Durations 

To enter task durations: 

1. Enter the duration for Task 2. Open the mywbs file, and move the split bar to the 
right, if  needed, to reveal the Duration, Start, and Finish columns. Click the 
Duration column for row 2, Stakeholder identification, type 1w, and then press 
Enter. Notice that the duration for the first task, Initiating, also changed since it is 
a summary task and is an Automatically scheduled task, as shown in the Task 
Mode column. When you created summary tasks earlier, Project changed their 
scheduling mode to Automatic. Also notice that the Start and Finish date for Task 
2 remain blank, since that task is a Manually scheduled task. 

2. Enter the duration for Task 3. In the Duration column for row 3, Stakeholder 
register completed, type 0, and then press Enter. Remember that a task with zero 
duration is a milestone. Notice the milestone or diamond symbol next to the date 
9/9 that appears on the Gantt chart, as shown in Figure A-30. Adjust the Task 
Name column width to see all of  the text, and use the Zoom slider on the bottom 
right of  the screen to change the length of  the Gantt chart bars. 

 

Figure A-30. Entering task durations 

3. Make all tasks Automatically scheduled tasks. To save time because you do want 
most of  the tasks to be automatically scheduled, select all of  the tasks by clicking 
the Task Name column heading, and then click the Auto Schedule button under 
the Task tab, Tasks group. Most of  the durations change to 1. 

4. Enter remaining task durations. Continue to enter the durations using the 
information in Figure A-29 or Figure A-31. Do not enter durations for tasks not 
listed in the figure. Notice that the Planning Wizard dialog box displays when you 
make the same entry several times in a row, such as after task 20. Click OK to close 
the dialog box. You can adjust the column widths and Zoom, if  desired. 
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Figure A-31. Entering more durations  

5. Insert a recurring task above Task 26, Team meetings. Click Team review meetings 

(Task 26) in the Task Name column to select that task. Click the Task tab, and 
click the Task button drop-down box under the Insert group, and then click 
Recurring Task. The Recurring Task Information dialog box opens. 

6. Enter task and duration information for the recurring task. Type Team review 
meetings as the task title in the Task Name text box. Type 15min in the Duration 
text box. Select the Weekly radio button under Recurrence pattern. Make sure that 
1 is entered in the Recur every list box. Select the Thursday check box. In the 
Range of  recurrence section, type 9/12/13 in the Start text box (or select it with 
the drop-down calendar), click the End by radio button, and then type 12/5/13 in 
the End by text box (or select it in the calendar), as shown in Figure A-32. The 
new recurring task will appear above Task 26, Team review meetings, when you are 
finished. Delete task 40, Team review meetings, by right clicking anywhere in row 
40 and selecting Delete Task.  
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Figure A-32. Recurring task information dialog box 

TIP: You can also enter a number of occurrences instead of an End by date for a recurring 
task. You might need to adjust the End by date after you enter all of your task durations 
and dependencies. Remember, the date on your computer determines the date listed as 
Today in the calendar. 

7. View the new summary task and its subtasks. Click OK. Project 2013 inserts a new 
Team review meetings subtask in the Task Name column. To collapse the recurring 
task, click the collapse symbol. Move your mouse over the Recurring Task 
symbol in the Indicator column for row 26 to read the note about it occurring 13 
times. Notice that the recurring task appears on the appropriate dates on the Gantt 
chart. 

8. Adjust the columns displayed and the timescale. Move the split bar so that only the 

Task Name and Duration columns are visible. If  needed, increase the Duration 
column’s width so all of  the text is visible. Click the Zoom Out button on the 
Zoom slider in the lower left of  the screen to display all of  the symbols in the 
Gantt chart. Your screen should resemble Figure A-33. 
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Figure A-33. All task durations and recurring task entered 

9. Save your file and name it. Click File on the Menu bar, and then click Save As. 
Enter myschedule as the filename, and then save the file to the desired location 
on your computer or network. Notice that all of  the tasks still begin on 9/9/13. 
This will change when you add task dependencies. Keep this file open for the next 
set of  steps. 

Establishing Task Dependencies 

To use Project 2013 to adjust schedules automatically and perform critical path analysis, 
you must determine the dependencies or relationships among tasks. There are several 
different methods for creating task dependencies: using the Link Tasks button, using the 
Predecessors column of the Entry table or the Predecessors tab in the Task Information 
dialog box, or clicking and dragging the Gantt chart symbols for tasks with dependencies. 
You will use the first two methods in the following steps. 

To create dependencies using the Link Tasks button, highlight tasks that are 
related and then click the Link Tasks button under the Task tab, Schedule group. For 
example, to create a finish-to-start (FS) dependency between Task 1 and Task 2, click any 
cell in row 1, drag down to row 2, and then click the Link Tasks button. The default type of 
link is finish-to-start. In the Project A+ file, you will also set up some other types of 
dependencies and use the lag option to set up overlaps between dependent tasks. 

TIP: To select adjacent tasks, click and drag the mouse to highlight them. You can also 
click the first task, hold down the Shift key, and then click the last task. To select 
nonadjacent tasks, hold down the Control (Ctrl) key as you click tasks in order of their 
dependencies. 

When you use the Predecessors column of the Entry table to create dependencies, 
you must manually enter the information. To create dependencies manually, type the task 
row number of the preceding task in the Predecessors column of the Entry table. For 
example, Task 3 has Task 2 as a predecessor, which can be entered in the Predecessors 
column, meaning that Task 3 cannot start until Task 2 is finished. To see the Predecessors 
column of the Entry table, move the split bar to the right. You can also double-click on the 
task, click the Predecessors tab in the Task Information dialog box, and enter the 
predecessors there. 
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Next, you will enter the predecessors for tasks as indicated. You will create some 
dependencies by manually typing the predecessors in the Predecessors column, some by 
using the Link Tasks button, and the remaining dependencies by using whichever method 
you prefer. 

To link tasks or establish dependencies for Project A+: 

1. Display the Predecessors column in the Entry table. Move the split bar to the right to 
reveal the full Predecessors column in the myschedule.mpp file you saved in the 
previous section. Widen the Task Name or other columns, if  needed. 

2. Highlight the cell where you want to enter a predecessor, and then type the task number for 
its predecessor task. Click the Predecessors cell for Task 3, Stakeholder register 
completed, type 2, and press Enter. Notice that as you enter task dependencies, 
the Gantt chart changes to reflect the new schedule. Also notice that several cells 
become highlighted, showing the Visual Change Highlights feature of  Project 
2013. 

3. Enter predecessors for Task 4 and view the Task Path. Click the Predecessors cell 
for Task 4, type 2, and press Enter. Click the Format tab, and then click the Task 
Path button under the Bar Styles group. Experiment with the options to highlight 
Predecessor, Driving Predecessors, Successors, and Driven Successors, and then 
click Remove Highlighting. 

4. Establish dependencies using the Link Tasks button. To link Tasks 5 and 6, click the 
task name for Task 5 in the Task Name column and drag down through Task 6. 
Then, in the Task tab, click the Link Tasks button (looks like a chain link) under 
the Schedule group. Notice that the result is the same as typing 5 in the 
Predecessors column for Task 6, as shown in Figure A-34. 

   Link Tasks icon                Predecessors            Changes in Gantt chart 

 

Figure A-34. Entering predecessor 

5. Enter dependencies and lag time using the Task Information dialog box. Double-click on 
the Task Name for task 5, Project charter, and then click on the Predecessors 
tab in the Task Information dialog box. Click in the cell under Task Name, and 
then click the Task Name down arrow and select Stakeholder identification. 
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Click the Type drop down arrow to see the various types of  dependencies. For 
this task, you will keep the default type of  finish-to-start. Click the Lag drop 
down arrow, then type -50% and press Enter. (Lag means there is a gap between 
tasks, and lead or negative lag means there is an overlap). Your screen should 
resemble Figure A-35. Click OK to close the dialog box. Notice that the 
Predecessor column for task 5 displays 2FS-50%, meaning there is a finish-to-start 
relationship with task 2 and a lag of  -50%, meaning the task can start when task 2 
is 50% completed. 

 

Figure A-35. Entering predecessor information using the task information dialog 
box 

6. Enter remaining dependencies. Link the other tasks by either manually entering 
the predecessors into the Predecessors column, by using the Link Tasks button, or 
using the Task Information dialog box. Use the information in Figure A-36 to 
make your entries, being careful to leave some of  the predecessors blank, as 
shown. If  you have entered all data correctly, the project should end on 12/6, or 
December 6, 2013.  
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Task Row Task Name Predecessors 

3 Stakeholder register completed 2 

4 Stakeholder management strategy completed 2 

5 Project charter 2FS-50% 

6 Project charter completed 5 

7 Kickoff  meeting 2,6 

8 Kickoff  meeting completed 6,7 

9 Planning  

10 Schedule 5,12FS-50% 

11 Gantt chart completed 10 

12 Scope statement 5 

13 Initial scope statement completed 12 

14 Executing  

15 Deliverable 1 12 

16 Deliverable 2 18 

17 Deliverable 3 18 

18 Deliverable 1 completed 15 

19 Deliverable 2 completed 16 

20 Deliverable 3 completed 17 

21 Monitoring and Controlling  

22 Actual hours tracking 2 

23 Project documents updates 3 

24-40 Progress Report 1 through Closing  

41 Final project report 18,19,20 

42 Final presentation 18,19,20 

43 Project completed 41,42 

Figure A-36. Predecessor information for Project A+ 
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7. Adjust several dates. You know that you have to deliver the two progress reports 

on specific dates. Click on the Start dates for Tasks 24 and 25 and change those 
dates to October 10 and November 7. Also change the Finish dates for tasks 22 
and 23 to December 4 to make those dates more realistic. Project 2013 will 
display a yellow warning symbol to remind you that you are changing default dates, 
which is fine in these examples. 

8. Review the file. If  needed, click the Zoom Out button on the Zoom slider to 
adjust the timescale so all of  the information shows on your screen. When you 
finish, your screen should resemble Figure A-37. Double-check your screen to 
make sure you entered the dependencies correctly. 

 

Figure A-37. Project A+ file with durations and dependencies entered 

9. Preview and save your file. Click the File tab, and then select Print to preview and 
print your file. Click Page Setup, and then click the option to Fit to 1 so it will 
print on one page, as shown in Figure A-38.  Be careful before printing any Project 
2013 files so you do not waste a lot of  paper. When you are finished, click Save to 
save your file again. Keep the file open for the next set of  steps. 
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Figure A-38. Project A+ set up to print on one page 

Gantt Charts, Network Diagrams, and Critical Path Analysis 

Project 2013 shows a Gantt chart as the default view to the right of the Entry table. As 
described earlier in this text, network diagrams are often used to show task dependencies. 
This section explains important information about Gantt charts and network diagrams and 
describes how to make critical path information more visible in the Gantt Chart view. 

Because you have already created task dependencies, you can now find the critical 
path for Project A+. You can view the critical tasks by changing the color of those items in 
the Gantt Chart view. Tasks on the critical path will automatically be red in the Network 
Diagram view. You can also view critical path information in the Schedule table or by using 
the Critical Tasks report. 

To make the text for the critical path tasks appear in red on the Gantt chart: 

1. Change the critical tasks format. Using the myschedule.mpp file you previously 
saved, click the Format tab, and then click the Critical Tasks check box in the 
Bar Styles group, as shown in Figure A-39. Notice that the critical tasks display in 
red in the Gantt chart. You can also quickly change the Gantt Chart Style by 
clicking one of  those options. 
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   Critical Tasks check box 

 

Figure A-39. Formatting critical tasks 

2. View the network diagram. Click the View tab, and then click the Network 
Diagram button under the Task Views group Click the Zoom Out button on the 
Zoom slider several times and watch the view change. Figure A-40 shows all of  the 
tasks in the Project A+ network diagram. Note that milestone tasks, such as 
Stakeholder management strategy completed, the fourth box on the top, appear as 
pointed rectangular boxes, while other tasks appear as rectangles. Move your 
mouse over that box to see it in a larger view. Notice that tasks on the critical path 
automatically appear in red. A dashed line on a network diagram represents a page 
break. You often need to change some of  the default settings for the Network 
Diagram view before printing it. As you can see, network diagrams can be messy, 
so you might prefer to highlight critical tasks on the Gantt chart as you did earlier 
for easier viewing. 

 

Figure A-40. Network diagram view 

3.  View the schedule table.  Click the Gantt Chart button under the View tab to 
return to Gantt Chart view. Right-click the Select All button to the left of  the 
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Task Mode column heading and select Schedule. Alternatively, you can click the 
View tab and click the Tables button under the Data group and then select 
Schedule. The Schedule table replaces the Entry table to the left of  the Gantt 
Chart. Your screen should resemble Figure A-41. This view shows the start and 
finish (meaning the early start and early finish) and late start and late finish dates 
for each task, as well as free and total slack. Right-click the Select All button and 
select Entry to return to the Entry table view. 

Select All button  Schedule table 

 

Figure A-41. Schedule table view 

4. Open the Project Overview report. Click the Report tab, and click the Dashboards 
button under the View Reports group, and then click Project Overview to open 
the Overview Reports, as shown in Figure A-42. Note that the report shows the 
milestones due and % complete. Examine other reports, as desired. 

5. Close the report and save your file. When you are finished examining the reports, 
click the Save button on the Quick Access toolbar to save your final 
myschedule.mpp file, showing the Entry table and Gantt chart view. Close Project 
2013 if  you are not continuing to the next section. 
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Figure A-42. Project Overview report 

HELP: If you want to download the Project 2013 file myschedule.mpp to check your 
work or continue to the next section, a copy is available on the companion Web site for 
this text at www.intropm.com. 

Next you will explore some of the cost and resource management features of 
Project 2013. 

PROJECT COST AND RESOURCE MANAGEMENT 

Many people do not use Project 2013 for cost or resource management. Some 
organizations have more established cost management software products and procedures in 
place, and many people simply do not know how to use the cost or resource management 
features of Project 2013. However, these features make it possible to integrate total project 
information more easily. This section offers brief instructions for entering fixed and 
variable cost estimates, assigning resources to tasks, viewing resource histograms, and 
entering actual cost and schedule information after establishing a baseline plan. It also 
explains how to use Project 2013 for earned value management. More details on these 
features are available in Project Help, online tutorials, or other texts. See other chapters of 
this text for information on some of these concepts. 

Entering Fixed and Variable Cost Estimates 

You can enter costs as fixed or variable. Fixed costs include costs like a specific quantity of 
materials or costs for consultants hired at a fixed cost. Variable costs vary based on the 
amount of materials or hours people work.  On many projects, human resource costs are 
the largest percentage of total project costs.  
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Entering Fixed Costs in the Cost Table 

The Cost table allows you to easily enter fixed costs related to each task. You will enter a 
fixed cost of $200 related to Task 15, Deliverable 1. 

To enter a fixed cost: 

1. Display the Cost Table view. Open your Project 2013 file myschedule.mpp, if  
necessary. Right-click the Select All button to the left of  the Task Mode column 
heading and select Cost. The Cost table replaces the Entry table to the left of  the 
Gantt chart. Widen the Task Name column and then move the Split bar to the 
right, as needed, until you see the entire Cost table. 

2. Enter a fixed cost. In the Fixed Cost column for Task 15, Deliverable 1, type 

200 and press Enter. Notice that the Total Cost and Remaining Cost columns 
reflect this entry, and changes are made to the summary task, Executing, as well. 
Your screen should resemble Figure A-43. 

Select All button    Fixed Cost column of  cost table 

 

 

Figure A-43. Entering a fixed cost 

Entering Resource Information and Cost Estimates 

Several methods are available for entering resource information in Project 2013. The 
Resource Sheet allows you to enter the resource name, initials, resource group, maximum 
units, standard rate, overtime rate, cost/use, accrual method, base calendar, and code. Once 
you have established resources in the Resource Sheet, you can assign those resources to 
tasks in the Entry table with the list arrow that appears when you click a cell in the 
Resource Names column. The Resource Names column is the last column of the Entry 
table. You can also use other methods for assigning resources, such as using the Assign 
Resources button or using the split window, which is the recommended approach to have 
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the most control over how resources are assigned because Project 2013 makes several 
assumptions about resources assignments that might mess up your schedule or costs. Next, 
you will enter information for three people working on Project A+ and assign them to a 
few tasks using various methods. 

To enter basic information about each person into the Resource Sheet and assign 
them to tasks using the Entry table and toolbar: 

1. Display the Resource Sheet view. Click the View tab, and then click the Resource 
Sheet button under the Resource Views group. 

2. Enter resource information. Enter the information from Figure A-44 into the 
Resource Sheet. The three resources names are Kathy, Dan, and Scott. The Std. 
Rate and Ovt. Rate for Kathy is 40, and the Std. and Ovt. Rates for Dan and Scott 
are 30. Type the information as shown and press the Tab key to move to the next 
field. When you type the standard and overtime rates, you can just type the 
number, such as 40, and Project 2013 will automatically enter $40.00/hr. The 
standard and overtime rates entered are based on hourly rates. You can also enter 
annual salaries by typing the annual salary number followed by /y for “per year.” 
Your screen should resemble Figure A-44 when you are finished entering the 
resource data. 

 

Figure A-44. Resource sheet view with resource data entered 

TIP: If you know that some people will be available for a project only part time, enter their 
percentage of availability in the Max Units column of the Resource Sheet. Project 2013 will 
then automatically assign those people based on their maximum units. For example, if 
someone can work only 50% of his or her time on a project throughout most of the 
project, enter 50% in the Max Units column for that person. When you enter that person 
as a resource for a task, his or her default number of hours will be 50% of a standard eight-
hour workday, or four hours per day. You can also enter the number of hours each person 
is scheduled to work, as shown later. 

3. Assign resources to tasks. From the View tab, select the Gantt Chart button 
under the Task Views group, and then click the Select All button and switch back 
to the Entry table. Move the Split bar to reveal the Resource Names column, if 
needed. 

4. Assign Kathy to task 2, Stakeholder identification. Click in the Resource Names cell 
for row 2. Click the list arrow, click on the checkbox by Kathy, and then press 
Enter or click on another cell. Notice that the resource choices are the names you 
just entered in the Resource Sheet. Also notice that after you select a resource by 
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checking the appropriate checkbox, his or her name appears on the Gantt chart, as 
shown in Figure A-45. To assign more than one resource to a task using the list 
arrow, simply select another checkbox. Note that Project 2013 will assume that 
each resource is assigned full-time to tasks using this method since the task is in 
automatically schedule mode. Also note that you can use filter by Resource Names 
to only show tasks assigned to specific resources after you enter the resources. 

        Filter Resource Names 

 

Figure A-45. Resource assigned using the entry table 

5. Assign two resources to a task. Click in the Resource Names cell for row 5 
(Project charter). Click the list arrow, then click on the checkbox by Dan and 
Kathy, and then press Enter. Notice that both resource names appear in the 
Resource Names column and on the Gantt chart for this task, and the task 
duration remains at 1 week.  

6. Change the resource assignments. Click in the Resource Names cell for Task 2, 
Stakeholder identification, click the list arrow, and add Dan as another resource. 
Notice that when you change an original resource assignment, Project prompts you 
for how you want to handle the change, as shown in Figure A-46. Click the 
Exclamation point symbol to read your options. In past versions of  Project, 
resource additions would change schedules automatically unless the user entered 
them a certain way. Now you have much more control of  what happens to your 
schedule and costs. In this case, we do want to accept the default of  keeping the 
duration constant. 

 

Figure A-46. Options when additional resources are added to tasks 

7. Review the cost table. Right-click the Select All button to the left of  the Task 
Mode column heading and select Cost. Notice that costs have been added to the 
tasks where you added resources. Project assumes that people are assigned full-
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time to tasks. It is showing a cost of  $2,800 each for Task 2 and Task 5. In the next 
section, you will see how to control resources entries even more. First, right-click 
the Select All button to the left of  the Task Mode column heading and select 
Entry to return to the Entry table. 

To control resource and work assignments using the Resource details window: 

1. Open the Resource Form. Notice the red symbols in the Indicator columns for 
rows/tasks 2 and 5. Move your mouse over the symbol to read the message about 
resources being overallocated. Click the Task Name for row 2, Stakeholder 
identification, click the Resource tab, and then click on the Details button under 
the Properties group. A Resource Form is displayed at the bottom of  the screen, 
as shown in Figure A-47. Project 2013 assumes every task is assigned full-time, so 
since Kathy is scheduled on two tasks on the same day, it says she is overallocated.  

TIP:  You can right-click on the lower screen to review see additional 
forms/views. You can click the Select All button at the top right of the screen to 
view different tables at the top of the screen. You want to make sure that resource 
and work hour assignments do not adjust your schedules in ways you did not 

intend. 

2. Make tasks 2 and 5 manually scheduled. Click the Select All button and switch to 
the Entry table. Click the drop-down in the Task Mode column for Tasks 2 and 
5 to make them manually scheduled. When you assigned resources, Project 2013 
assumed they were working full-time or 40 hours per week on each task. Because 
these two tasks have days that overlap, there is an overallocation. You do not 
expect each resource to work that many hours, so you can change them by using 
the Resource Form. 

3.  Change the number of  Work hours. Select Task 2, Stakeholder identification in 
the top window, and then click the Work column in the Resource Form window 
for Kathy in the lower part of  your screen. Type 10h, press Enter, and again type 
10h and press Enter for the next task, Task 5, Project charter, and then click the 
OK button. Click Next to see Dan’s Resource Form, as shown in Figure A-47. 
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Task mode indicator Change # work hours         

Figure A-47. Changing Work hours for tasks 

4. Enter additional work hours and review the Gantt chart. Change Dan’s work hours to 
10h for Tasks 2 and 5 as well. Notice in the Gantt chart that the duration for 
Tasks 2 and 5 are still one week. The overallocation indicator should now 
disappear because the number of  hours has been reduced from the default of  8 
hours per day, or 40 hours for a 5-day task. To remove the Resource Form, click 
Details on the Ribbon under the Resource tab. 

5. Examine the new cost information. Click the Select All button, and then click 
Cost to view the Cost table. Tasks 2 and 5 each show only $700 for Total Cost. 

6. Close the file without saving it. Close the file, but do not save the changes you 
made. 

Using the Team Planner Feature 

Another way to assign resources and reduce overallocations is by using the Team Planner 
feature. Assume you have two people assigned to work on a project, Brian and Cindy, as 
shown in Figure A-48. Notice that Brian is assigned to work on both Task 1 and Task 2 
full-time the first week. Therefore, Brian is overallocated.  Cindy is scheduled to work on 
Task 3 full-time the second week, and Task 4, also scheduled for the second week, is not 
assigned yet.  
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Overallocation indicator 

 

Figure A-48. Overallocated resource 

 You can click on the Team Planner view under the View tab to see a screen similar 
to the top section of Figure A-49. Notice that Brian has both Tasks 1 and 2 assigned to 
him at the same time. These tasks and Brian’s name display in red to show the 
overallocation. Cindy is assigned Task 3 the following week, and Task 4 is unassigned. By 
simply clicking and dragging Task 4 straight up so it is under Brian in Week 2 and Task 2 
straight down so it is under Cindy in Week 1, you can reassign those tasks and remove 
Brian’s overallocation, as shown in the bottom section of Figure A-49. Many people will 
appreciate the simplicity of this feature, first introduced in Project 2010! 

Before moving tasks in the Team Planner View: 

 
 
After moving tasks in the Team Planner View: 

 

Figure A-49. Adjusting resource assignments using the Team Planner feature 

Entering Baseline Plans, Actual Costs, and Actual Times 

After entering information in the Task Name column, establishing task durations and 
dependencies, and assigning costs and resources, you are ready to establish a baseline plan. 
By comparing the information in your baseline plan to actual progress during the course of 
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the project, you can identify and solve problems. After the project ends, you can use the 
baseline and actual information to plan similar, future projects more accurately. To use 
Project 2013 to help control projects and view earned value information, you must 
establish a baseline plan, enter actual costs, and enter actual durations. In the next series of 
steps you will use a new file called tracking.mpp that you downloaded from the companion 
Web site for this text (www.intropm.com). 

To save a file as a baseline and enter actual information: 

1. Open the file called tracking.mpp. The file should be showing the Cost table view. 
Notice that this short project was planned to start on January 7, 2013 and end on 
February 13 of the same year, have three resources assigned to it, and cost $11,200. 
Click the Project tab, click the Set Baseline button under the Schedule group, and 
click Set Baseline, as shown in Figure A-50. 

Select All button   Set Baseline 

 

Figure A-50. Saving a baseline 

2. Save the file as a baseline. Examine the Set Baseline dialog box. Click the drop-
down arrow to see that you can set up to ten baselines. Accept the default to save 
the entire project. Click OK. Notice that the Baseline column changes to blue. 

3.  Display the Tracking table. Click the Task tab, right-click the Select All button 
and then click Tracking to view the tracking table. Move the split bar to the right 
to reveal all of  the columns in the table, if  needed. Move your mouse over each 
tracking button in the Ribbon in the top line of  the Schedule group to see what it 
does. Your screen should resemble Figure A-51 
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     Tracking table         Tracking buttons 

 

Figure A-51. Using the tracking table and tracking buttons 

4. Mark Tasks 2 through 4 as 100% complete. Click the Task Name for Task 2, 
Subtask 1 under Main task 1, and drag down through Task 4 to highlight 
those tasks. Click the 100% Complete button on the Ribbon. The columns 
with dates, durations, and cost information should now contain data instead of  
the default values, such as NA or 0. The % Comp. column should display 
100%. Adjust column widths if  needed. Your screen should resemble Figure 
A-52. Notice that the Gantt chart bars for those three tasks now have a black 
line through them. 

Figure A-52. Tracking table information 

5. Enter actual completion dates for Task 6. Click the Task Name for Task 6, 
Subtask 1 under Main task 2, click the Mark on Track drop-down, and 
then click Update Tasks. The Update Tasks dialog box opens. For Task 6, 
enter the Actual Start date as 1/28/13 (the same as the Current Start date) and 
the Actual Finish date as 2/11/13 (ten days later than the Current Finish date), 
as shown in Figure A-53. Click OK. Notice how the information in the 
tracking sheet has changed. 



56 Appendix A – Microsoft Project 

 

 

Figure A-53. Update Tasks dialog box 

6. View the Tracking Gantt chart. Click the drop-down arrow on the far left of  
the screen where it says Gantt chart, and then click Tracking Gantt to quickly 
switch to that view. Move the split bar and adjust column widths as needed. 
Use the horizontal scroll bar in the Gantt chart window to the right (move 
the slider to the left) to see symbols on the Tracking Gantt chart. Use the 
Zoom slider on the lower right of  the screen to adjust the timescale so you 
can see all of  the symbols. Your screen should resemble Figure A-54. The blue 
bar for task 6 shows the actual time you just entered. Notice that the delay in 
this one task on the critical path has caused the planned completion date for 
the entire project to slip (now Feb 25 versus Feb 13). Also notice the Indicator 
column to the far left. The check marks show that tasks are completed. 

Completion indicator                     Tracking Gantt chart 

 

Figure A-54. Tracking Gantt chart view 

7. Save your file as a new file named myactuals.mpp. Click File on the Menu bar, and 
then click Save As. Name the file myactuals, and then click Save. 

Notice the additional information available on the Tracking Gantt chart. 
Completed tasks have 100% by their symbols on the Tracking Gantt chart. Tasks that have 
not started yet display 0%. Tasks in progress, such as Task 5, show the percentage of the 
work completed (35% in this example). The project summary task bar indicates that the 
entire project is 57% complete. Viewing the Tracking Gantt chart allows you to easily see 
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your schedule progress against the baseline plan. After you have entered some actuals, you 
can review earned value information for the initiating tasks of this project. 

VIEWING EARNED VALUE MANAGEMENT DATA 

Earned value management is an important project management technique for measuring 
project performance. Because you have entered actual information, you can now view 
earned value information in Project 2013. You can also view an earned value report using 
the visual reports feature.   

 To view earned value information: 

1. View the Earned Value table. Using the myactuals file you just saved (or 
downloaded from the companion Web site), click the Select All button, select 
More Tables, and double-click Earned Value. Move the split bar to the right to 
reveal all of  the columns, as shown in Figure A-55. Note that the Earned Value 
table includes columns for each earned value acronym, such as PV, EV, AC, SV, 
CV, etc. Also note that the EAC (Estimate at Completion) is higher than the BAC 
(Budget at Completion) for Task 6 (and its summary task, Task 5), where the task 
took longer than planned to complete. Task 0 shows a VAC (Variance at 
Completion) of  ($3,360.00), meaning the project is projected to cost $3,360 more 
than planned at completion. Remember that not all of  the actual information has 
been entered yet. Also note that the date on your computer must be set later than 
the date of  a completed task for the data to calculate properly. 

 

Figure A-55. Earned value table 

2. View the earned value chart. Click the Report tab, and then click Costs under the 
View Reports group, and then click Earned Value Report, as shown in Figure A-
56. You can experiment with different report options or click the link to Learn 
more about earned value, as desired. 
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Figure A-56. Earned value report 

3. Close Project 2013 without saving the file. Click the File tab, click Close, and select 
No when prompted to save the file. You can also exit Project 2013 and take a 
break, if  desired. 

Next you will use a few more features of Project 2013 to help tie your Project to 
other applications. 

INTEGRATING PROJECT 2013 WITH OTHER 
APPLICATIONS AND APPS FOR OFFICE 

Project 2013 provides several features to make it easy to integrate with other applications. 
For example, you can copy data between Project 2013 and other applications (including the 
timeline), or you might want to create hyperlinks to project documents created in Word, 
Excel, PowerPoint, or other applications from within your project files. You can also 
purchase and add new apps to Project 2013 from Microsoft’s Office Store. 

Copying Information Between Applications 

Most people are familiar with copying information between Office applications. For 
example, you can highlight a column of data in Excel, select copy, and then select Paste in 
Project 2013 or other applications. You can also create a new Project 2013 file from an 
existing Excel file by select New from Excel Workbook. It is also easy to copy a timeline 
from Project 2013 into another application. 
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To copy a timeline from Project 2013: 

1.  Open another Project 2013 template file. Start Project 2013, and open a template 
file, such as Residential Construction, as shown in Figure A-57.  Notice the 
timeline near the top of  the screen. 

 

Figure A-57. Residential construction template 

 

2.  Make changes to the Timeline. Move your mouse over the second item on the 
Timeline called Site Work. Right-click on Site Work, and select Remove from 
Timeline. 

3.  Open the Insert Hyperlink dialog box. Click on Task 4, right-click Apply for 
Permits, and then click Add to Timeline.  (Note that this milestone could be 
worded better to indicate that it has no duration, such as Permit Applications 
Submitted). Make other adjustments to the Timeline, as desired. 

3.  Copy the Timeline into PowerPoint. Click anywhere on the Timeline, and then click 
the Copy Timeline button in the Copy group on the Ribbon, as shown in Figure 
A-58, and select For Presentation. 

4.  Copy the Timeline into PowerPoint. Open PowerPoint, change the slide layout, add 
a title to the slide, and change the theme, as desired, and then right-click and 
select Paste picture. Your screen should resemble Figure A-59, showing the 
Project 2013 Timeline in your presentation. 
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      Copy Timeline 

 

Figure A-58. Copy Timeline 

 

Figure A-59. Timeline copied into PowerPoint 
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Creating Hyperlinks to Other Files 

Some people like to use their Project 2013 file as a main source of information for many 
different project documents. To do this, you can simply insert a hyperlink to other 
document files. For example, you can create a hyperlink to the file with the stakeholder 
register you listed as a milestone in your Task Name column earlier. 

 To insert a hyperlink within a Project 2013 file: 

1.  Open the myschedule.mpp file. Use the file you saved earlier or download it 
from the companion Web site for this text. The Entry table and Gantt Chart view 
should display. 

2.  Select the task in which you want to insert a hyperlink. Click the Task Name for Task 
3, Stakeholder register completed. 

3.  Open the Insert Hyperlink dialog box. Right-click in that cell, then click Hyperlink. 
The Insert Hyperlink dialog box opens, as shown in Figure A-60. You will have 
different folders visible based on your computer’s directory structure. 

 

Figure A-60. Insert hyperlink dialog box 

4. Double-click the filename of  the hyperlink file. Change the Look in: information 
until you find where you have saved the files you downloaded for this appendix. 
Double-click the Word file named stakeholder register, and then click OK. A 
Hyperlink button appears in the Indicators column to the left of  the Task Name 
for Task 3. Move your mouse over the hyperlink button until the mouse pointer 
changes to the Hand symbol to reveal the name of  the hyperlinked file. If  you 
click on it, the file will open. 
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Using Project 2013 Apps 

Microsoft has an Office Store where you can download special apps for Project 2013. New 
apps are added often. 

 To explore Project 2013 apps: 

1.  Access the Office Store. With Project 2013 open, click the Project tab, then click 
the Apps for Office button on the left of  the Ribbon under the Apps group. The 
Apps for Office dialog box opens, as shown in Figure A-61. 

 

Figure A-61. Apps for Office dialog box 

2.  Explore the Office Store. Click the Office Store button. Your screen should resemble 
Figure A-62, which shows the apps available on April 6, 2013. Read information about 
various apps, and add them as desired. 
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Figure A-62. New Apps for Project on the Office Store (April, 2013) 

 You have really just touched the surface of Project 2013’s powerful features, but 
you probably know more than most people who have this software! There are several 
books with more detailed information on using Project 2013 that you can use to learn even 
more, or you can experiment with the software and Help feature to understand it more. 
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DISCUSSION QUESTIONS 

1. What are some unique features of  project management software? 

2. What are the new features of  Project 2013? 

3. How do you create a WBS in Project 2013? 

4. How do you enter task durations and establish dependencies between tasks? 

5. How can you make sure that resource assignments do not mess up your schedule?  

6. How can you use the Team Planner to assign resources and reduce overallocations? 

7. How do you establish a baseline in Project 2013 and enter actual information? 

8. What type of  information do you see in the Earned Value table? 

9. How can you copy a Timeline from Project into other applications and access 
other application files from within Project 2013? 

10.  Where can you access apps created for Project 2013? 

EXERCISES 
1. To make sure you understand the information in this appendix, perform the steps 

yourself. Print out the following screens or send them to your instructor, as 
directed:  
a. The adjusted Customer Service file as shown in Figure A-13. 
b. The Schedule table view for the Customer Service file, similar to Figure A-

16. 
c. The Customer Service file filtered to show only milestones, similar to 

Figure A-21. 
d. The mywbs file with automatic outline numbers and a project summary 

task, similar to Figure A-25. 
e. Create a new Project file called generic-wbs that shows the WBS for a 

generic project. Make the main categories phase 1, phase 2, phase 3, and 
phase 4. Include at least four tasks and one milestone under each of these 
main categories, using meaningful, fictitious names for them. Enter 0 for 
the duration of the milestones, but do not enter any durations for the 
other tasks. Be sure to indent tasks and show the outline numbers before 
printing or submitting the file. Note: If you are doing a project for your 
class, you can use data for that project instead. 
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2. Continue performing the steps in this appendix, starting with the section called 

Developing the Schedule.  Print out the following screens or send them to your 
instructor, as directed:  
a. The myschedule file with durations and dependencies entered, similar to 

Figure A-38. 
b. The earned value table, similar to Figure A-55.  
c. Continue performing the steps, even if you do not have to print out more 

screens.  Write a one-to-two page paper describing the capabilities of 
Project 2013 and your opinion of this software. What do you like and 
dislike about it? 

3. Use some of the information in the body of the text An Introduction to Project 
Management or Healthcare Project Management (or find a sample WBS and Gantt chart 
on your own). Enter the WBS into Project 2013 to practice your Project 2013 
skills. 
a. Review one of the sample WBSs provided in Chapter 4 (or that you find 

elsewhere). Indent tasks and use the automatic numbering feature. Print 
out or submit your file. 

b. Use the information in Chapter 4 under the section called Developing the 
Project Schedule to create the Gantt chart for Project X. Also create the 
network diagram for Project X. Make sure both will print out on one page 
each, then print or submit them to your instructor. Assume the start date 
was 6/9/09, or June 9, 2009, to make your results match the screen shots 
in Chapter 4. (Or use a similar project you find elsewhere). 

c. Make up actual information for Project X (or a similar project). Assume 
some tasks are completed as planned, some take more time, and some take 
less time. View and then print out or submit the tracking Gantt chart. 

4. If you are doing a team project as part of your class or for a project at work, use 
Project 2013 to create a detailed file describing the work you plan to do for the 
project. 

a. Create a detailed WBS, including several milestones, estimate task 
durations, link tasks, add tasks to the timeline, and enter resources and 
costs, assign resources, and so on. Save your file as a baseline and print it 
out send it to your instructor, as desired.  

b. Track your progress on your team project by entering actual cost and 
schedule information. Create a new baseline file if there have been a lot of 
changes. View earned value information when you are halfway through 
the project or course. Continue tracking your progress until the project or 
course is finished. Print or submit your Gantt chart, Project Summary 
report, Earned Value table, and relevant information to your instructor. 

c. Write a two- to three-page report describing your experience. What did 
you learn about Project 2013 from this exercise? How do you think 
Project 2013 helps in managing a project? You may also want to interview 
people who use Project 2013 for their experiences and suggestions. 
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